Important Information

SOME TIBCO SOFTWARE EMBEDS OR BUNDLES OTHER TIBCO SOFTWARE. USE OF SUCH EMBEDDED OR BUNDLED TIBCO SOFTWARE IS SOLELY TO ENABLE THE FUNCTIONALITY (OR PROVIDE LIMITED ADD-ON FUNCTIONALITY) OF THE LICENSED TIBCO SOFTWARE. THE EMBEDDED OR BUNDLED SOFTWARE IS NOT LICENSED TO BE USED OR ACCESSED BY ANY OTHER TIBCO SOFTWARE OR FOR ANY OTHER PURPOSE.

USE OF TIBCO SOFTWARE AND THIS DOCUMENT IS SUBJECT TO THE TERMS AND CONDITIONS OF A LICENSE AGREEMENT FOUND IN EITHER A SEPARATELY EXECUTED SOFTWARE LICENSE AGREEMENT, OR, IF THERE IS NO SUCH SEPARATE AGREEMENT, THE CLICKWRAP END USER LICENSE AGREEMENT WHICH IS DISPLAYED DURING DOWNLOAD OR INSTALLATION OF THE SOFTWARE (AND WHICH IS DUPLICATED IN THE LICENSE FILE) OR IF THERE IS NO SUCH SOFTWARE LICENSE AGREEMENT OR CLICKWRAP END USER LICENSE AGREEMENT, THE LICENSE(S) LOCATED IN THE “LICENSE” FILE(S) OF THE SOFTWARE. USE OF THIS DOCUMENT IS SUBJECT TO THOSE TERMS AND CONDITIONS, AND YOUR USE HEREOF SHALL CONSTITUTE ACCEPTANCE OF AND AN AGREEMENT TO BE BOUND BY THE SAME.

This document contains confidential information that is subject to U.S. and international copyright laws and treaties. No part of this document may be reproduced in any form without the written authorization of TIBCO Software Inc.

TIBCO, Two-Second Advantage, TIBCO Spotfire, TIBCO Enterprise Runtime for R, TIBCO Spotfire Server, TIBCO Spotfire Web Player, TIBCO Spotfire Statistics Services, S-PLUS, and TIBCO Spotfire S+ are either registered trademarks or trademarks of TIBCO Software Inc. in the United States and/or other countries.

All other product and company names and marks mentioned in this document are the property of their respective owners and are mentioned for identification purposes only.

THIS SOFTWARE MAY BE AVAILABLE ON MULTIPLE OPERATING SYSTEMS. HOWEVER, NOT ALL OPERATING SYSTEM PLATFORMS FOR A SPECIFIC SOFTWARE VERSION ARE RELEASED AT THE SAME TIME. SEE THE README FILE FOR THE AVAILABILITY OF THIS SOFTWARE VERSION ON A SPECIFIC OPERATING SYSTEM PLATFORM.

THIS DOCUMENT IS PROVIDED “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, OR NON-INFRINGEMENT.

THIS DOCUMENT COULD INCLUDE TECHNICAL INACCURACIES OR TYPOGRAPHICAL ERRORS. CHANGES ARE PERIODICALLY ADDED TO THE INFORMATION HEREIN; THESE CHANGES WILL BE INCORPORATED IN NEW EDITIONS OF THIS DOCUMENT. TIBCO SOFTWARE INC. MAY MAKE IMPROVEMENTS AND/OR CHANGES IN THE PRODUCT(S) AND/OR THE PROGRAM(S) DESCRIBED IN THIS DOCUMENT AT ANY TIME.

THE CONTENTS OF THIS DOCUMENT MAY BE MODIFIED AND/OR QUALIFIED, DIRECTLY OR INDIRECTLY, BY OTHER DOCUMENTATION WHICH ACCOMPANIES THIS SOFTWARE, INCLUDING BUT NOT LIMITED TO ANY RELEASE NOTES AND “READ ME” FILES.

Copyright © 1999-2015 TIBCO Software Inc. ALL RIGHTS RESERVED.

TIBCO Software Inc. Confidential Information
TIBCO Spotfire Statistics Services Documentation and Support Services

All TIBCO documentation is available on the TIBCO Documentation site, which can be found here: https://docs.tibco.com

TIBCO Spotfire Statistics Services Documentation

The following documents for this product can be found in the TIBCO Documentation Library:

- TIBCO Spotfire® Statistics Services Release Notes
- TIBCO Spotfire® Statistics Services Installation and Administration Guide
- TIBCO Spotfire® Statistics Services User’s Guide
- TIBCO® Enterprise Runtime for R Package Management
- TIBCO Spotfire® Statistics Services Java API Reference
- TIBCO Spotfire® Statistics Services C# API Reference
- TIBCO Spotfire® Statistics Services URL API Reference
- TIBCO Spotfire® Statistics Services SpotfireUtils Package Reference
- TIBCO Spotfire® Statistics Services License Agreement

Product System Requirements

For a list of system requirements for this product and other TIBCO Spotfire® products, visit this site: http://support.spotfire.com/sr.asp

How to Contact TIBCO Support

For comments or problems with this manual or the software it addresses, contact TIBCO Support as follows:

- For an overview of TIBCO Support, and information about getting started with TIBCO Support, visit this site: http://www.tibco.com/services/support
- If you already have a valid maintenance or support contract, visit this site: https://support.tibco.com
  Entry to this site requires a user name and password. If you do not have a user name, you can request one.

How to Join TIBCOmmunity

TIBCOmmunity is an online destination for TIBCO customers, partners, and resident experts. It is a place to share and access the collective experience of the TIBCO community. TIBCOmmunity offers forums, blogs, and access to a variety of resources. To register, go to:

http://www.tibcommunity.com
Packages in TIBCO Predictive Analytics

You can build, test, and deploy both S language packages and Spotfire packages (SPKs) in the TIBCO predictive analytics platform.

The following products comprise the TIBCO predictive analytics platform:

- TIBCO Spotfire® Professional Client.
- TIBCO Spotfire® Server.
- TIBCO Spotfire® Web Player.
- TIBCO Spotfire® Statistics Services.
- TIBCO® Enterprise Runtime for R engine.

Each of these products plays a role in building, using, and maintaining packages.

Spotfire Professional Client users who have licenses to create and use Data Functions and S package developers who want to create or download S packages for distribution in the predictive analytics platform can learn to:

- Build S language packages to use with the TIBCO Enterprise Runtime for R engine.
- Create an SPK from a collection of S language packages to use with the Data Functions tools in a local installation of Spotfire Professional Client.
- Store the S language packages in a Spotfire Statistics Services repository, where both Spotfire Web Player users and Spotfire Professional Client users can access the functions used by their Spotfire analyses.
- Deploy the SPK to the Spotfire Server for Spotfire Professional Client users throughout your organization.

S Language Primer

The S language has developed into a handful of versions—specifically, S-PLUS®, the open-source R engine, and the TIBCO® Enterprise Runtime for R engine.

Some differences exist among these, specifically between the open-source R engine and the S-PLUS engine; whereas the open-source R engine and the TIBCO Enterprise Runtime for R engine are highly compatible. That is, most scripts and functions that you write in open-source R run in the TIBCO Enterprise Runtime for R engine.

Open-source R is available under separate open source software license terms and is not part of TIBCO Enterprise Runtime for R. As such, open-source R is not within the scope of your license for TIBCO Enterprise Runtime for R. Open-source R is not supported, maintained, or warranted in any way by TIBCO Software Inc. Download and use of open-source R is solely at your own discretion and subject to the free open source license terms applicable to open-source R.

We do not address writing scripts or developing packages for S-PLUS. (The extensive TIBCO Spotfire S documentation, available with that product, covers writing scripts and functions, and developing and deploying packages using its tools.) Nor do we teach S programmers how to write S scripts and functions or delve too deeply into how create S language packages.

Rather, we address techniques for skilled package developers who must test and share their packages across an organization that has deployed TIBCO Spotfire® and TIBCO Spotfire® Statistics Services, and that uses the TIBCO Enterprise Runtime for R engine to run the package code.
**S Language Options**

Regardless of the S language option you favor, you can find resources and tools in the TIBCO Spotfire® predictive analytics platform.

**TIBCO Enterprise Runtime for R Packages**

If you are an open-source R developer, test your functions using the TIBCO® Enterprise Runtime for R engine and use it to build your simple packages. (See R Package Anatomy for more information on limitations.)

**S-PLUS Packages**

If you are an S-PLUS developer looking for guidance for deploying packages to TIBCO Spotfire® Statistics Services, see the S-PLUS API reference available from the Spotfire Statistics Services landing page, or see the Spotfire S+ Workbench documentation for information about using its toolset to deploy packages to the server.

**Open-Source R Packages**

If you are an open-source R developer, you will probably use either your own packages or those downloaded from the Comprehensive R Archive Network (CRAN). You can test either by running them against a local TIBCO Enterprise Runtime for R engine.

TIBCO maintains a list of CRAN packages tested with TIBCO Enterprise Runtime for R engine. These tests include running only the example code provided by the package developer. TIBCO is not responsible for developing, testing, or supporting packages published to CRAN.

For a list of the CRAN packages for which we have run minimal example testing, see http://support.tibco.com.

- For more information about working with available packages, see Import Packages from Other Repositories.
- For more information about testing your open-source R packages, see Testing Packages Locally.
- Check the list of known differences between the open-source R engine and the TIBCO Enterprise Runtime for R engine by package.

**Reviewing the List of Known Differences**

In the installation TIBCO® Enterprise Runtime for R, you can find a list of known differences in function behavior between open-source R and TIBCO Enterprise Runtime for R.

**Procedure**

1. From the TIBCO® Enterprise Runtime for R console (available from the TIBCO Spotfire® installation's modules/TIBCO Enterprise Runtime for R_(version_#)/engine/bin directory).

   The modules directory is a hidden folder. If you do not see this folder in your Spotfire installation, from the Windows Explorer menu, click Tools > Options, and in the View tab, select Show hidden files, folders, and drives.

2. Double-click TERR.exe.

3. At the command prompt, type help.start().

4. In the resulting browser window, click the link Differences Between TIBCO Enterprise Runtime for R and Open-Source R on that page.
Result

The resulting web page provides detailed information of known differences in function behavior between TIBCO Enterprise Runtime for R and open-source R, sorted by their packages. (This list is compiled from like sections in the individual function help files.)
Checking Installed Packages

TIBCO® Enterprise Runtime for R includes a variety of packages, including packages for open-source R compatibility. You can find a list of packages from the TIBCO Enterprise Runtime for R console.

Procedure

1. Browse to the TIBCO Spotfire® installation directory modules/TIBCO Enterprise Runtime for R_(version_#)/engine/bin(where version # is the version of Spotfire available to you).
2. Double-click TERR.exe.
3. At the command prompt, type help.start().
4. In the resulting browser window, under References, click Included Packages.

Packages for Use with Spotfire

Notice that the list of installed packages contains a list of packages specifically for working with TIBCO Spotfire®.

<table>
<thead>
<tr>
<th>Package Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Spotfire</td>
<td>This package is deprecated. See SpotfireData.</td>
</tr>
<tr>
<td>SpotfireConnector</td>
<td>This package contains functions used between Spotfire and TIBCO Spotfire® Statistics Services. You would probably not call these functions directly.</td>
</tr>
<tr>
<td>SpotfireData</td>
<td>This package contains functions for managing datasets between Spotfire and TIBCO® Enterprise Runtime for R. (In particular, the functions are for reading and writing files in the Spotfire Binary Data format (SBDF).) Advanced users might consider importing their Spotfire data directly in the TIBCO Enterprise Runtime for R engine for debugging purposes.</td>
</tr>
<tr>
<td>SpotfireSPK</td>
<td>This package contains one function: buildSPK. Use this package to create an SPK to contain your S language packages that you want distributed to other Spotfire Professional users. (The packages in your SPK can be automatically distributed to Spotfire Professional users who are working with data functions with local TIBCO Enterprise Runtime for R engines.)</td>
</tr>
<tr>
<td>SpotfireStats</td>
<td>This package contains the statistical functions used by Spotfire predictive analytics.</td>
</tr>
<tr>
<td>SpotfireUtils</td>
<td>This package contains utility functions for interfacing between Spotfire and the TIBCO Enterprise Runtime for R engine.</td>
</tr>
</tbody>
</table>
Overview of Spotfire Packages

A TIBCO Spotfire® package (SPK) is usually created and tested by developers to package and deploy third-party extensions to the TIBCO Spotfire® Server, which can then be distributed to Spotfire Professional users. This mechanism has previously been available to Spotfire Professional users.

Even though they are both called “packages”, the Spotfire package (SPK) and the S package are different. The SPK is merely a means to deploy extensions to the Spotfire Server, which then distributes its contents to Spotfire Professional users.

We use the Spotfire package (SPK) deployment mechanism to distribute S packages to Spotfire Professional Client users who want to use the S package functionality to write data functions used by Spotfire data visualizations.

TIBCO Spotfire® Statistics Services contains an S package to build an SPK that contains one or more S packages. See Creating and Deploying a Spotfire Package, for more information.

The S packages bundled into an SPK are distributed to Spotfire Professional users who want to write data functions and create analyses using data functions. (For a visual overview of this process, see the section Package Workflow on page 20.)

This manual does not cover Spotfire packages in general, only those built using the SpotfireSPK package and containing S packages.
Find Help

TIBCO Spotfire includes many avenues to help with packages, whether they are S language packages or Spotfire packages (SPKs).

For more information about building packages for open-source R, see the R documentation.

Open-source R is available under separate open source software license terms and is not part of TIBCO Enterprise Runtime for R. As such, open-source R is not within the scope of your license for TIBCO Enterprise Runtime for R. Open-source R is not supported, maintained, or warranted in any way by TIBCO Software Inc. Download and use of open-source R is solely at your own discretion and subject to the free open source license terms applicable to open-source R.

For more information about Spotfire SPK distribution, see the TIBCO Spotfire® Deployment and Administration Manual.

For more information about Spotfire Statistics Services architecture and server management, see the TIBCO Spotfire® Statistics Services Installation and Administration Guide.

For more information about building packages using Spotfire S+, see TIBCO Spotfire S+ Guide to Packages.
Develop Packages for Use with the TIBCO Enterprise Runtime for R Engine

R language packages can run either in TIBCO® Enterprise Runtime for R for Statistics Services or in a local TIBCO® Enterprise Runtime for R for TIBCO Spotfire®.

You can create your own packages, using open-source R, and then you can:

- Run the packages locally, in Spotfire in the local TIBCO Enterprise Runtime for R for Spotfire.
- Deploy the packages on TIBCO Spotfire® Statistics Services to run in the TIBCO Enterprise Runtime for R engine on that server.

Using TIBCO Spotfire® Professional, you can create data functions to access the packages, and you can distribute them across your organization for rendering Spotfire visualizations.

Limitations and Considerations

Before you begin developing packages to use with TIBCO® Enterprise Runtime for R, you should familiarize yourself with some basic limitations.

Platform Considerations

You can develop or download open-source R packages to run on either LINUX® or Microsoft Windows® platforms. Therefore, when you write your code to run on the server, take into account the platform you expect it to run on.

- If you plan to run packages locally on a TIBCO Enterprise Runtime for R engine in TIBCO Spotfire®, your package must be a Windows binary package.
- If you plan to deploy a package to run in TIBCO Enterprise Runtime for R for Statistics Services, the package type must be binary, and it must match the platform of the Spotfire Statistics Services deployment.

Graphical and S4 Limitations

The TIBCO Enterprise Runtime for R engine can run as a statistical engine in Spotfire, which provides data visualizations. Therefore, the TIBCO Enterprise Runtime for R engine has no support for open-source R graphics functions. (However; we have implemented stub functions to allow the non-graphical portions of many packages to run without error.) You should always test package functions to make sure they run as expected.

Licensing Limitations

To make a data function available in an analysis published to a Spotfire library, you must have the appropriate licenses. If you are not sure of your licenses, or if you do not see the Tools > Register Data Functions menu in the Spotfire Professional client, see your Spotfire Administrator for more information.

R Package Anatomy

Open-source R Packages running in the TIBCO® Enterprise Runtime for R engine are binary, and they must follow the standard package component design and contain version information.

The TIBCO Enterprise Runtime for R engine is designed to be highly compatible with the open-source R engine. To develop packages using open-source R, see its documentation, available on the Comprehensive R Archive Network (CRAN).
Open-source R is available under separate open source software license terms and is not part of TIBCO Enterprise Runtime for R. As such, open-source R is not within the scope of your license for TIBCO Enterprise Runtime for R. Open-source R is not supported, maintained, or warranted in any way by TIBCO Software Inc. Download and use of open-source R is solely at your own discretion and subject to the free open source license terms applicable to open-source R.

A typical package is available as binary or source code. The TIBCO Enterprise Runtime for R engine supports only binary packages. You can install a binary or build a source package into a binary package and install it.

The TIBCO Enterprise Runtime for R engine does not support building packages that contain a `src` directory.

**Package Components**

A source package can contain any number of directories, including `html` (for the help index), `libs`, `help`, and so on. The simplest package requires the following files and directories:

<table>
<thead>
<tr>
<th>File or Directory</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>mypkg</code></td>
<td>The top-level directory name, which is also the package name (in this case, <code>mypkg</code>).</td>
</tr>
<tr>
<td><code>mypkg/NAMESPACE</code> file</td>
<td>Required. You must specify the NAMESPACE.</td>
</tr>
<tr>
<td><code>mypkg/DESCRIPTION</code></td>
<td>The file containing a description, the title, the author, date, the dialect, and version information, along with other information.</td>
</tr>
<tr>
<td><code>mypkg/R</code></td>
<td>The directory containing *<code>.R</code> files with S language functions as ASCII files.</td>
</tr>
<tr>
<td><code>mypkg/R/mycode.R</code></td>
<td>The S language code.</td>
</tr>
</tbody>
</table>

Your source package can also contain the following optional folders:

- `data` directory containing data files in a dump format.
- `man` directory containing help files in the `.Rd` help file format.
- `inst` directory contains files and directories to be copied, recursively, into the main package directory when the package is compiled. Any informational files that the end user should see should be included in the `inst` directory. For example, if you have a PDF containing a vignette, you can include it in the `inst/doc` directory.
- `src` directory, containing C, C++, or FORTRAN code.
- `tests` directory can contain package-specific tests. This directory can contain test code (that is, `.S`, `.ssc`, `.q`, and `.R`).

The TIBCO Enterprise Runtime for R engine does not support the following:

- Packages using graphics devices or containing graphics functions. (However; we have implemented stub functions to allow the non-graphical portions of many packages to run without error.)
- Building packages with `src` directories. (If you use the TIBCO Enterprise Runtime for R engine to build a package containing a `src` directory, the `src` directory is ignored. If your built binary package contains a `src` directory, you can use it with the TIBCO Enterprise Runtime for R engine.)
Package Versioning

Package version information is kept in the DESCRIPTION file. With every package revision, remember to revise the version number upward. This version number is an important part of your package management strategy.

Testing Packages Locally

After you have either created a package or downloaded a package from a repository such as the CRAN, you can test the package functions by running the example files in the TIBCO® Enterprise Runtime for R engine. Then you can write your own scripts using the package functions, and test them using TIBCO Enterprise Runtime for R for Spotfire.

Procedure

1. In your Spotfire installation, navigate to the modules/TIBCO Enterprise Runtime for R_(version_#)/engine/bin directory.
   - The modules directory is a hidden directory. You can display it from the Windows Explorer menu by clicking Tools > Folder options > View > Show hidden files, folders, and drives.

2. Double-click TERR.exe to start the TIBCO Enterprise Runtime for R console.
3. At the prompt, type library(packagename) to load the package.
4. Type or paste the script or example using your package functions that you want to run.
Package Management through Roles

Keeping package versions synchronized between your development machines, your testing machines, and your servers is one of your most important package management concerns in an organization.

Working with packages in a deployment that includes TIBCO Spotfire®, TIBCO Spotfire® Server, and TIBCO Spotfire® Statistics Services can add layers of complexity to management policies. You can reduce the risk of confusion and streamline your processes by defining roles in your organization for dealing with packages.

How packages stay in synch across an organization is managed internally with assigned roles, rules, and responsibilities. Tools and methodologies are company-specific and beyond the scope of this technical documentation; however, we advise ensuring such processes and rules are in place to manage packages prior to working with any package development, deployment, validation, and upgrade processes.

Developer Role

In the package world, the Developer is an S language programmer or statistician who develops S packages using S-PLUS or open-source R.

The Developer:

- Develops and tests the package locally.
- Knows the needs of the user who is going to be using the analysis.
- Knows who to give the package to so it is deployed to the appropriate computers or servers.

Guru Role

In the package world, the Guru maintains the standards and lists of officially-sanctioned packages. The Guru keeps all of the package versions synchronized. The Guru might be the same person who fills the Developer role.

The approval process for adding a packaging is up to your organization, and might vary from minimal to extensive, depending on your usual practices. We recommend designating a developer familiar with open-source R and TIBCO® Enterprise Runtime for R packages be assigned to maintain the list of tested and sanctioned package versions (“gold standard”). These would be the set of packages available for general use under Spotfire applications:

- Deployed to the Spotfire Server via the Spotfire package mechanism (SPK) and distributed to Spotfire Professional desktops.
- Uploaded to TIBCO Spotfire® Statistics Services for use by TIBCO Spotfire® Web Player users.

For any organization running analyses using these packages, it is vitally important that the packages used in these two scenarios are kept in synch.
Administrator Roles

The Spotfire Deployment Manager, the TIBCO Spotfire® Server Administrator, and the TIBCO Spotfire® Statistics Services Administrator might be one and the same person; however, the roles require slightly different responsibilities.

The responsibilities for these administrator roles include the following:

• The Spotfire Deployment Administrator is responsible for deploying the SPK to be distributed to Spotfire Professional users.

• The Spotfire Server Administrator might be responsible for assigning licenses for access to the Data Functions feature in Spotfire Professional.

• The Spotfire Statistics Services Administrator would be responsible for adding a package to the engine.init.file, in the case where the library should be loaded with every engine startup.
Package Workflow

Using packages with the TIBCO® Enterprise Runtime for R engine, TIBCO Spotfire® Statistics Services, and TIBCO Spotfire® is a two-part process.

The overarching processes for using packages are:

1. Stage the packages (including developing or downloading, testing, and deploying).
2. Distribute and use the packages.

Stage the Packages

The following image provides a high-level picture of the processes of staging packages, and then deploying them to a Spotfire Server package repository and to a Spotfire Statistics Services package repository.

1. Produce or download the package to use. For more information, see Creating the Spotfire Package.
2. Test using your local TIBCO Enterprise Runtime for R engine. (Available through your Spotfire Client installation, in Modules/TIBCO Enterprise Runtime for R _<version#/engine/bin.)
3. Using the SpotfireSPK library in your local TIBCO Enterprise Runtime for R engine, build the SPK. For more information, see the section Creating the Spotfire Package.
4. Hand off the SPK to a Spotfire user licensed to deploy the SPK for distribution (probably your Spotfire Server Administrator or Deployment Manager), who deploys it to the Spotfire Server.
5. Using the Eclipse plugin TSSS Connector, upload the original S package to Spotfire Statistics Services. For more information, see the section Using Package Updating Tools.
Distribute and Use the Packages

The following image provides a high-level picture of package distribution and use after it has been deployed to TIBCO Spotfire® Server and TIBCO Spotfire® Statistics Services.

To distribute and use the packages, you follow the workflow pictured above. These steps describe the numbers in the image.

1. When appropriately-licensed TIBCO Spotfire® Professionals launch Spotfire, they are notified by the server that a new distribution of the package is available. They accept the update.
2. Licensed Spotfire Professional users run Data Functions using the packages and the local TIBCO® Enterprise Runtime for R engine.
3. Alternatively, Spotfire Professional users run the Data Functions remotely using the TIBCO Enterprise Runtime for R engine on Spotfire Statistics Services.
4. TIBCO Spotfire® Web Player users access the Spotfire DXP (stored in the Spotfire Library) through the Web Player.
5. If the Spotfire DXP includes data function(s), the Spotfire Web Player accesses Spotfire Statistics Services to run the data function on the TIBCO Enterprise Runtime for R engine and returns the results to the Web Player, which renders the results in the Spotfire Web Player User browser.

Using TIBCO Enterprise Runtime for R data functions under the Spotfire Web Player requires a correctly-configured Spotfire Statistics Services. There is no local TIBCO Enterprise Runtime for R engine available through the Spotfire Web Player.
Import Packages from Other Repositories

The first step in using open-source R packages is either developing or downloading the package.

If you elect to download a package, you could do so from a public repository, such as CRAN, or you could have an internal package repository, managed by your Package Guru.

Open-source R is available under separate open source software license terms and is not part of TIBCO Enterprise Runtime for R. As such, open-source R is not within the scope of your license for TIBCO Enterprise Runtime for R. Open-source R is not supported, maintained, or warranted in any way by TIBCO Software Inc. Download and use of open-source R is solely at your own discretion and subject to the free open source license terms applicable to open-source R.

Public Repositories

You can download open-source packages from CRAN-like repositories, and then use the functions in the package in your data functions in TIBCO Spotfire. Be sure to review the list of differences between the TIBCO® Enterprise Runtime for R engine, available from the TIBCO Enterprise Runtime for R landing page. Also review the limitations and considerations.

Company Repositories

We strongly recommend that one skilled package developer in your organization should have the role of Package Guru to oversee the package version integrity within the company’s package repository, whether these are packages downloaded and tested from a public repository or developed internally and kept in a CRAN-like internal repository.

For more information about installing existing packages, see Installation Options for Packages.

Installation Options for Packages

Use the TIBCO Enterprise Runtime for R function *install.packages()* to install packages to use in TIBCO Enterprise Runtime for R either in the stand-alone console, or in Spotfire. You can find packages in a variety of locations, including repositories, on reliable web sites, or stored locally. See the TIBCO Enterprise Runtime for R help topic for *install.packages()* for more detail and examples.
<table>
<thead>
<tr>
<th>Installation Location</th>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Trusted URL</td>
<td>If you are given a URL that contains a package you might want to use, and you trust the URL, you can pass the URL as the only argument to <code>install.packages()</code></td>
<td>#download from github and install # the Windows version of the custom # TERR version of Rcpp. URL &lt;- &quot;<a href="https://raw.github.com/">https://raw.github.com/</a> TIBCOSoftware/&quot; URL &lt;- paste(URL, &quot;terr-Rcpp/master/ inst/&quot;, sep=&quot;&quot;) URL &lt;- paste(URL, &quot;binary/ Rcpp_0.11.3-0.zip&quot;, sep=&quot;&quot;) install.packages(URL)</td>
</tr>
</tbody>
</table>
Packages Deployed Manually to a Small Group

The Package Guru can also oversee distributing packages to a small group. You might consider such distributions because the TIBCO Spotfire® Server can contain only one SpotfireSPK.spk. Recreating the package and redeploying it overwrites the version that was previously deployed to the Spotfire Server.

The Package Guru can distribute packages manually either by simply sharing the TIBCO® Enterprise Runtime for R packages and explaining to users how to load them, or by including the loading in data functions distributed with Spotfire DXPs.

Alternatively, users with access to the Eclipse plugin TSSS Connector can download packages directly in the Eclipse environment by right-clicking the package name, clicking Download Package, and then saving the package to a local package repository. See Deploying Packages to Spotfire Statistics Services for more information.

Remember to follow your organization’s rules to keep package versions synchronized, regardless of the distribution mechanism you use.
Spotfire Packages and R Binary Packages

TIBCO Spotfire® has two different types of packages: the Spotfire package (SPK), and the S language binary package (usually R).

The SPK is specific to Spotfire add-in development and deployment. You can create a Spotfire package (SPK) that contains TIBCO® Enterprise Runtime for R engine-compatible R binary packages, and then deploy the SPK to a TIBCO Spotfire® Server to be distributed to other users in your organization who have the skills and the Spotfire licenses to work with the R binary packages.

The Spotfire Professional client, version 5.0 or later, can include a license for the TIBCO Enterprise Runtime for R local engine. Your R binary packages, deployed using the SPK mechanism, can be used to create Spotfire analyses that use data functions.

R binary packages can run faster in a local TIBCO Enterprise Runtime for R engine than one running in the TIBCO Enterprise Runtime for R engine installed remotely on a TIBCO Spotfire® Statistics Services installation. For more information see Packages Running on a Local TIBCO Enterprise Runtime for R Engine in Spotfire.

Because you are creating or downloading a package to be distributed to Spotfire Professional clients, the package must be a Windows binary package. See Limitations and Considerations for more information.

To create the SPK containing your R binary packages, you need the SpotfireSPK package.

Obtaining the SpotfireSPK Toolset

To generate a TIBCO Spotfire® SPK package containing your R packages, which you want to deploy to Spotfire Professional clients in your organization, you must have access to a TIBCO Spotfire® Statistics Services installation, from which you can download the required toolset.

You must have access to Spotfire Statistics Services and you must have installed Spotfire.
Procedure

1. From your server administrator, get the URL for a deployment of Spotfire Statistics Services 5.0 or later. This URL takes the following form:

   http://SName:P#/SC

   where SName is the server name, P# is the port number, and SC is the server context. For example, it might be something like:

   http://US-TSSS:8080/TERRServer

   To test the correctness of the URL, just type it in a browser address box. You should see the Spotfire Statistics Services landing page.

2. In your file system, browse to the installation of the TIBCO® Enterprise Runtime for R console. In Microsoft Windows®, for example, this might be:

   C:\Program Files (x86)\TIBCO\Spotfire\(version#)\Modules\TIBCO Enterprise Runtime for R_(version#)\TERR\bin\TERR.exe.

   Remember that the modules directory is a hidden directory. To display it, from the Windows Explorer menu, click Tools > Folder options, and then in the View tab, select Show hidden files, folders, and drives.

3. Double-click the console executable to bring up the TIBCO Enterprise Runtime for R console.

   To display help, at the console prompt, type help.start(). A browser window should open and display the landing page for the console, including links to the built-in TIBCO Enterprise Runtime for R packages and this book.
4. From the TIBCO Enterprise Runtime for R console command line prompt, type the following:

   install.packages("SpotfireSPK", repos="http://SN#P#/SC/update/TERR")

   where SName is the server name, P# is the port number, and SC is the server context.

   The following messages indicate that the SpotfireSPK package is installed.

   Trying to download URL 'http://...'
   * installing *binary* package SpotfireSPK from "C:\...

5. Next, at the command line, type the following to load the library:

   library("SpotfireSPK")

   The library is loaded in your TIBCO Enterprise Runtime for R session, and you are now ready to build the SPK to contain your TIBCO Enterprise Runtime for R-compatible binary packages.

6. Review the Help for its only function, buildSPK, by typing the following in at the command-line in the TIBCO Enterprise Runtime for R console:

   ?buildSPK

   This function takes several optional arguments; check with your server administrator regarding certificate and password requirements.

**SpotfireSPK Versioning**

SpotfireSPK.spk is the file that you send to the Spotfire Server to distribute packages to other statistical analysts who are using Spotfire Professional Client. If you are creating this file, and you need to update it, you must know how to create a new version of the file.

You can create a SpotfireSPK using TIBCO Enterprise Runtime for R (TERR), as described in Creating the Spotfire Package. The TERR buildSPK function creates this SPK using the following versioning rules.

- The property BuiltVersion is NOT the same as the package version. That information is stored in the package DESCRIPTION file.

For more information about the TERR function buildSPK, load the TERR package SpotfireSPK and read its help file. See Obtaining the SpotfireSPK Toolset for more information.

<table>
<thead>
<tr>
<th>Task</th>
<th>Detail</th>
</tr>
</thead>
<tbody>
<tr>
<td>Generating a new DCF</td>
<td>If you generate a new DCF using writeLines or a text editor, the buildSPK function overwrites any previously-generated DCF, and the list contains only the packages you provide in the text argument of writeLines. The BuiltVersion is always set to 1.0.0.</td>
</tr>
<tr>
<td>Recreating a new DCF using the same version</td>
<td>If you do not need to increment or keep the older DCF, you can just regenerate it using writeLines. Creating a new DCF always sets BuiltVersion to 1.0.0 by default. However, if you use this method of generating the DCF, Spotfire Server does not register the package as a new one, so it does not distribute it to the users.</td>
</tr>
<tr>
<td>Adding package names to an existing DCF</td>
<td>If you only add packages to the existing DCF using a text editor, and then run the buildSPK function, passing in the edited DCF, the buildSPK function increments the BuiltVersion to a minor version number (for example, 1.1.0).</td>
</tr>
</tbody>
</table>

TIBCO Spotfire® Package Management
<table>
<thead>
<tr>
<th>Task</th>
<th>Detail</th>
</tr>
</thead>
<tbody>
<tr>
<td>Removing package names form an existing DCF</td>
<td>If you remove a package from the existing DCF using a text editor, and then run the <code>buildSPK</code> function, passing in the edited DCF, the <code>buildSPK</code> function increments the <code>BuiltVersion</code> to a major version number (for example, 2.0.0).</td>
</tr>
<tr>
<td>Assigning a specific version number to a DCF</td>
<td>If you create a DCF and want to assign a specific version number to it, run the <code>buildSPK</code> function and pass in the DCF argument, along with the argument <code>version</code>, setting it to the version you want. This argument is a character string or a numeric version object containing four components (for example, <code>version = &quot;1.2.3.4&quot;</code>).</td>
</tr>
</tbody>
</table>

### Creating the Spotfire Package

Practice building an SPK that contains only one package: the `rpart` package downloaded from the Comprehensive R Archive Network (CRAN).

The `rpart` R package is compatible with TIBCO® Enterprise Runtime for R; however, note that its examples use the `plot` function, which is not supported in version 3.1.0.

When you prepare an SPK to be deployed to the TIBCO Spotfire® Server, remember the following rules:

- The SpotfireSPK can contain as many S packages as you need.
- Only one SpotfireSPK is allowed on the server; if you redeploy it, it overwrites your previously-deployed SPK.
- To distribute an updated SpotfireSPK to the Professional Clients using the server, the SpotfireSPK must have its `BuiltVersion` incremented. See

This example walks you through installing a package, generating the list, Install your package and make sure it works.

**Procedure**

1. Install a package to be in your SpotfireSPK file. For example:
   ```r
   install.packages("rpart")
   ```
2. Generate the Debian Control File (DCF) listing the packages to pass to `buildSPK`.
   ```r
   writeLines("Packages: rpart", "SpotfireSPK.dcf")
   ```

   **Important:** See SpotfireSPK Versioning for information about creating the DCF and versioning the SPK.
3. **Build the SPK.** (In this example, you are building the SPK package without passing any arguments for certificates or passwords, and the resulting output specifies that your resulting SPK is unsigned.)

```r
buildSPK("SpotfireSPK.dcf", "SpotfireSPK.spk")
```

Note that "SpotfireSPK.spk" is not signed.

building SpotfireSPK.spk.

Done.

If you do not include the arguments certificate and password in your buildSPK function, when the package is distributed, Spotfire Professional client users see a message warning of an unsigned file, and they are prompted to accept or reject the installation. This message appears for every update of the unsigned package. See your server administrator for a certificate and password to include.

4. **Print the new list file.**

```r
cat(readLines("SpotfireSPK.dcf"), sep="\n")
```

```
Packages: rpart
Built: TERR 3.1.0 (includes date and time)
BuiltName: TIBCO Enterprise Runtime for R Packages
BuiltId: F13B9A7E-783A-432a-8676-42FCD3022D70
BuiltVersion: 1.0.0.0
BuiltPackages: rpart (>=3.1-55)
```

(Your output will vary.)

5. **Browse your Spotfire installation for the SPK file and the DCF file.** You should find both in the engine\bin directory of your TIBCO Enterprise Runtime for R Module directory.

Remember that you can have only one SpotfireSPK package deployed to your Spotfire Server, and you can use the DCF list to keep track of the packages in the SPK. We recommend you keep this list where you can update it as necessary. See Packages Deployed Manually to a Small Group for more information.

### Deploy the Spotfire Package to the Spotfire Server

You deploy the TIBCO Spotfire® package (SPK) created by buildSPK the same way you deploy any package to the TIBCO Spotfire® Server. See your Spotfire Server Administrator for more information.

When the SPK is deployed to the Spotfire Server, users running Spotfire are informed upon Spotfire Professional Client startup that an upgrade is available, or, if the deployment option forces an upgrade, the new S packages in the SPK are distributed automatically.

If you did not provide a certificate when you build the SPK, the user is asked to accept the unsigned file. See your Spotfire Administrator for more information, or to get a copy of a certificate and its password.
Running functions locally requires making the TIBCO® Enterprise Runtime for R engine available under TIBCO Spotfire® Professional.

- The SpotfireSpotfire package containing the TIBCO Enterprise Runtime for R engine to be deployed to the TIBCO Spotfire® Server.
- The appropriate licensing to be enabled by your Spotfire Administrator.
- A URL for a TIBCO Spotfire Statistics Services deployment that has a TIBCO Enterprise Runtime for R engine configured for use.

Given those conditions, you can configure your Spotfire Professional client to use the local TIBCO Enterprise Runtime for R engine using the Tools > Options > Data Functions dialog. See the Spotfire documentation for more information.

Also, appropriately-licensed SpotfireSpotfire Professional users might be running analyses that depend on data functions stored in the library that take advantage of your package.

In Spotfire, these scenarios are possible because it includes an embedded TIBCO Enterprise Runtime for R engine. With enough resources, you can efficiently test and run analyses using data functions locally.

Although the package is in your Spotfire installation, it is not loaded into the engine. To use the package, you must load the library as part of your data function script or include it in the Packages field of your data function.

### Getting Package Help

Each package you download or build should have help files. If you are writing data functions or developing analyses that use the functions in a package, you might want to see Help topics associated with them.

**Procedure**

1. In TIBCO Spotfire®, open a sample DXP file.
2. From the Tools menu, click Register Data Functions.
3. In the Script window, type help.start().
4. Click Run. Click OK in the resulting parameters dialog.
   
   A browser window opens displaying the TIBCO® Enterprise Runtime for R landing page.
5. Under Reference, click Included Packages.
6. In the resulting Available Packages page, note that your package is listed. Click its name.
7. From the resulting page, select the function for which you want help.

Changing the Local Option

If you decide that you do not want to use TIBCO Enterprise Runtime for R for Spotfire, you can specify in TIBCO Spotfire® to use TIBCO® Enterprise Runtime for R for Statistics Services containing the same package.

Procedure

1. In the Spotfire Professional client, click Tools > Options.
2. In the left pane, scroll down and select Data Functions.
3. In the Data Functions pane, provide the URL to the TIBCO Spotfire® Statistics Services (for example, http://CoTSSS:8080/TERRServer).
4. Clear the checkbox Use locally installed TIBCO Enterprise Runtime for R, and then click OK to accept.

Remember that you need to have the same package version on your local installation and on the server. See your package “Guru” for help.

The Advanced Analytic Tools in Spotfire always use the local TIBCO Enterprise Runtime for R engine, regardless of this setting.
Spotfire Package Maintenance

Package maintenance involves making sure you have the same version of a given package deployed across your organization.

We recommend that you assign one person in your organization the task of maintaining the S packages and versions distributed via the SpotfireSPK deployment mechanism, as well as those uploaded to TIBCO Spotfire® Statistics Services.

If you need to add one or more binary packages to the SPK, or if you need to update an existing package, you can recreate the SpotfireSPK.spk as described in Creating the Spotfire Package.

There can be only one SpotfireSPK.spk at a time on the TIBCO Spotfire® Server. Redeploying the SPK overwrites the existing one, and TIBCO Spotfire® Professional users are prompted to update when they next start Spotfire.

Be sure to communicate to others who might be running analyses using their local TIBCO Enterprise Runtime for R engine of any changes.
Package Repository in Spotfire Statistics Services

TIBCO Spotfire® Statistics Services houses a repository for the packages containing functions that can be used by Spotfire analyses. These packages should be identical to those packages distributed to the installations of the Spotfire Professional client.

See Package Management through Roles for more advice about keeping packages synchronized.

You can use an existing Eclipse installation to connect to Spotfire Statistics Services, adding a package to a Spotfire Statistics Services installation, and then validating its existence there.
Package Updating Tools

TIBCO Spotfire® Statistics Services includes in its installation two Eclipse plugins designed for you to use to deploy packages to Spotfire Statistics Services.

The Spotfire Statistics Services plugins for Eclipse are:

- An updating tool for the package uploader found in TIBCO Spotfire® S+ Workbench (along with an updating tool for the S-PLUS Package for remote submission).
- The TSSS Connector, a tool for uploading open-source R and TIBCO® Enterprise Runtime for R packages for a stand-alone Eclipse installation.

We support version 3.6 or later of Eclipse for the remote submission tools.

For more detailed information about updating or installing the plugins described above, see the Spotfire Statistics Services updates page:

http://SName:P#/SC/update

where SName is the server name, P# is the port number, and SC is the server context (for example, http://CoTSSS:8080/TERRServer/update).

If you need more information about the Spotfire S+ Workbench plugin, see Chapter 4 of the TIBCO Spotfire S+ Workbench User’s Guide.

Connecting to the Service

The TSSS Connector plugin requires further configuration to connect to TIBCO Spotfire® Statistics Services. This section walks you through establishing that connection.

Procedure

1. After you have installed the TSSS Connector plugin and Eclipse restarts, if you haven’t done so already, from the Eclipse Window menu, click Show View > Other .
2. From the list, select Statistics Services.
3. Anchor the view wherever you want to display it in the Eclipse environment.
4. In the view, click the green plus sign to add the service.
5. In the Add Service Connection, type the service name you want to display (For example, MyServer).
6. Type the Server URL (for example, http://CoTSSS:8080/TERRServer).
7. Supply a user name. This can be any name.
8. Click Submit. The service is added.

Result

Note that under the server name (in this case, MyServer), three folders appear. Only one, Packages, is currently supported. The Jobs folder only displays a list of jobs sent to the Service, and the Data folder is reserved for future use.
Uploading a Package

Now that you have established a connection to the service, you can begin uploading your packages. To complete these steps, you must have built the package archive, or downloaded a compatible package from a CRAN-like repository.

Binary (built) packages are required. Source packages must be built before they can be uploaded to TIBCO Spotfire® Statistics Services.

Spotfire Statistics Services accepts .zip archives (Microsoft Windows® servers only) or .tar.gz archives (Linux® servers only). Be sure you upload packages that match the versions distributed via SPK to Spotfire Professional users of the local TIBCO® Enterprise Runtime for R engines. See Develop Packages for Use with the TIBCO Enterprise Runtime for R Engine for more information.

Procedure

1. Right-click the Packages folder.
2. From the menu, select Upload Package.
3. Supply the location of your package archive.
4. Add the archive. The package is now on the server.

   Although the package is on the server, it is not loaded into the engine. With each call to the server, the engine is started anew. Unless your server administrator adds the package name to the engine.init.file, you must call library(packagename) as part of your function script.

   We recommend loading the library as part of your function scripts or included in the Packages field of your data function; however, you can discuss your options with your Spotfire Statistics Services Administrator.

Validating the Upload

After you upload a package, run a quick validation to ensure that your package is on the server.

Procedure

1. In a browser window, open the landing page for the server, for example, http://CoTSSS:8080/TERRServer.
2. In the browser address line, following your server’s address, append the following:

/api/v8/function/utils/installed.packages.

The resulting XML file displays header information and a character vector containing all of the installed packages. The recently-added rpart package should be close to the top:

```xml
<ComponentK>
  <Vector Length="20" type="character">
    <Item>rpart</Item>
    <Item>datasets</Item>
    <Item>Spotfire</Item>
    <Item>SpotfireConnector</Item>
    <Item>SpotfireData</Item>
    <Item>SpotfireStats</Item>
    <Item>SpotfireUtility</Item>
    <Item>assertionTest</Item>
    <Item>base</Item>
    <Item>compiler</Item>
    <Item>parallel</Item>
    <Item>datasets</Item>
    <Item>Devices</Item>
    <Item>graphics</Item>
  </Vector>
</ComponentK>
```
Package Maintenance on Spotfire Statistics Services

Keep the package versions in synch across your TIBCO Spotfire® Professional deployments and the TIBCO Spotfire® Statistics Services deployments.

After you add a package to the server, you can check its properties using the Statistics Services view in Eclipse.

Right-click the package name, and from the menu, select **Package Properties**.

The Properties dialog box appears, and information on the package, drawn from its DESCRIPTION file, is displayed.

Update the package as needed, and then follow the steps to upload the package. See **Uploading a Package**.